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Initial Info



macOS Meta Keys



macOS meta keys

⌘ Command ⇥ Tab ␣ Space

⌥ Option or Alt fn Function → Right

⌃ Control ⌫ Delete ← Left

⇧ Shift ↩ Return ↑ Up

⎋ Escape ⌅ Enter (fn+↩) ↓ Down



macOS 
Disclosure Buttons



Always click on disclosure buttons







To open all disclosure boxes by default, open Terminal, 
enter the following on one line, & press ↩: 

defaults write -g 
NSNavPanelExpandedStateForSaveMode -bool true

Then do the same thing with this: 

defaults write NSGlobalDomain 
NSNavPanelExpandedStateForSaveMode2 -bool true



Same thing for printing







To open Show Details by default, open Terminal, enter 
the following on one line, & press ↩: 

defaults write NSGlobalDomain 
PMPrintingExpandedStateForPrint -bool true



/ & \



/ is a slash (or forward slash) used by every 
operating system in the world (e.g., macOS, Linux, 
UNIX, but not Windows) to denote file paths 

» /Users/dbowie/Documents 
» Web Dev Projects/colors/index.html 

\ is a backslash used by Windows to denote file paths 

» C:\Users\dbowie\Documents 
» Web Dev Projects\colors\index.html



Sometimes macOS, Linux, UNIX, & Windows use the \ 
to escape a character 

Escaping a character tells the operating system or 
program to treat the following character in a special way 

For example, \n means “this is a newline, a line break 
created by ↩” & not the letter n 

If you see a \ followed by a character, unless it’s a 
Windows path, it’s probably an escape



Webpage URLs only use the / 

https://www.granneman.com/teaching/web-
development-granneman-way



Unzipping



 

After downloading a ZIP file (e.g., foo-bar.zip), just 
double-click on the file & you will have a folder named 
foo-bar next to the ZIP file 

Done! 🎉 

Throw away the ZIP file if you want



What about zipping up a folder or files? 

Right-click (or ⌃-click) & select Compress



⊞ 

After downloading a ZIP file (e.g., foo-bar.zip), do not 
double-click on the ZIP file! 

Instead, right-click on the ZIP file & select Extract All… 

A folder named foo-bar should appear 

Throw away the ZIP file if you want

😖







Stupid Windows — why create a 

folder inside a folder? 🤓



😬



What about zipping up a folder or files? 

Right-click on the folder or file & select Send to > 
Compressed (zipped) folder





& now you can rename it



⊞ 

If you do not see Extract All…, you have a 3rd-party 
unzipping program installed 

Look for something else



⊞ 

And by the way, if you really want a 3rd-party tool… 

1. uninstall yours 
2. go to www.7-zip.org 
3. download 7-Zip & install it

https://www.7-zip.org
https://www.7-zip.org


Show Extensions



Before we do anything else in this course, we need to 
make sure that extensions (e.g., .html, .zip, .jpeg) 
show up at the ends of files



 

Click on the Finder 

Click on Finder > Preferences 

Click on the Advanced tab 

Check the box next to Show All Filename Extensions 

Close the Preferences window



⊞ 

Refer to Configuring Windows To Show Extensions at 
www.granneman.com/tech/windows/showextensions/ 
& follow those directions

https://www.granneman.com/tech/windows/showextensions/
https://www.granneman.com/tech/windows/showextensions/


Main Project Folder



We need a place to store all your project work 

Go to your Documents folder 

If you are not using your own computer, go to a cloud 
drive (e.g., Dropbox, One Drive, Box, or Google Drive) 
& create a Documents folder there 

Create a new folder named exactly Web Dev Projects



Why VSCode?



I’ve always been looking for an editor that met all 3 
conditions — with VSCode, I found it

Free

Cross-platform 

⊞🐧

Powerful



Visual Studio Code is a powerful source code editor 

» Debugging 
» Embedded Git control 
» Syntax highlighting 
» Intelligent code completion 
» Snippets 
» Code refactoring 
» Highly customizable theme, keyboard shortcuts, & 

preferences 
» Updated every month!



Installation





VSCode is available for download at 
code.visualstudio.com

https://code.visualstudio.com
https://code.visualstudio.com


Click this







A file named something like VSCode-darwin-
stable.zip will appear in Downloads 

Double-click on the ZIP file & a few moments later you 
will see Visual Studio Code.app



Drag VSCode into the Applications folder



Toss the ZIP file into the Trash (or just select the file & 
press ⌘⌦)



c



A file named something like VSCodeSetup-
x64-1.24.0.exe will download 

Double-click on the EXE installer



If you’re asked if you want to “allow the following 
program to install software on this computer”, click Yes 

Click Next 

Accept the agreement 

Click on Next until you click on Install 

Click Finish



Toss the EXE installer into the Recycle Bin





A file named something like code_1.38.0-1567547996_
amd64.deb will download 

Debian/Ubuntu: sudo apt install ./<file>.deb

Installing the .deb package automatically installs the 
APT repository & signing key to enable auto-updating 
using your system’s package manager



Snap: sudo snap install --classic code 

RHEL, Fedora, & CentOS: sudo dnf install code or 
sudo yum install code 

openSUSE & SLE-based: sudo zypper install code 

Arch: makepkg -si visual-studio-code-bin 

Nix: nix-env -i vscode



Portable VSCode



Don’t have a laptop you can install VSCode on? 

You can install Visual Studio Code in Portable Mode, 
which runs on…  

» a USB flash drive 
» a portable hard drive 
» cloud storage (Dropbox, One Drive, Box, iCloud 

Drive, or Google Drive)



When you use VSCode in Portable Mode, all your 
extensions, settings, & other data reside in a folder 
along with the app 

You can therefore access & use VSCode from anywhere 
& have access to your setup without having to reinstall 
or reconfigure!







A file named something like VSCode-darwin-
stable.zip will appear in Downloads 

Double-click on the ZIP file & a few moments later you 
will see Visual Studio Code.app



Drag VSCode into your Dropbox folder



Toss the ZIP file into the Trash (or just select the file & 
press ⌘⌦)



Go to your Applications folder 

Double-click on VSCode to open it 

Once it is open, go ahead & close it



In your Applications folder, create a new folder named 
exactly code-portable-data 

Now when you run VSCode, all your extensions & data 
will live in the code-portable-data folder



Next time you automatically update VSCode, everything 
should just work



c



Click on 
Other platforms



Click on 64 bit zip 
(unless you have an 
ancient PC)



A file named something like VSCode-win32-
x64-1.26.1.zip will download 

Right-click on the ZIP file & select Extract Here 

You should now have a folder named something like 
VSCode-win32-x64-1.26.1

Drag that folder into your USB or cloud drive



Toss the ZIP into the Recycle Bin



Go into the VSCode folder (e.g., VSCode-win32-
x64-1.26.1) & its 63 items (!) 

Note that to run the VSCode app, you need to click on 
Code.exe 

Create a folder named data in the same folder as 
Code.exe 

Now when you run VSCode, all your extensions & data 
will live in the data folder



Next time you update VSCode, follow the same 
procedure with the ZIP file 

However, drag the data folder from the old installation 
folder (e.g., VSCode-win32-x64-1.26.1) into the new 
installation folder (e.g., VSCode-win32-x64-1.27.1) 

Toss the old installation folder (e.g., VSCode-win32-
x64-1.26.1) into the Recycle Bin







A file named something like code-stable-
1567547931.tar.gz will download 

tar -xvzf code-stable-1567547931

You should now have a folder named something like 
VSCode-linux-x64

Drag that folder into your USB or cloud drive



Go into the VSCode-linux-x64 folder 

Note that to run the VSCode app, you need to run code 

Create a folder named data in the same folder as code 

Now when you run VSCode, all your extensions & data 
will live in the data folder



Next time you update VSCode, follow the same 
procedure with the TAR.GZ file 

However, drag the data folder from the old installation 
folder into the new installation folder 

Toss the old installation folder into the Recycle Bin



How VSCode 
Works



Open VSCode



The GUI





Editor



Breadcrumbs



Minimap



Activity Bar



Side Bar, showing Explorer View



Name of current project



All files in current project (folder)



Currently open files



Tabs



Status Bar



Panels 
1. Problems 
2. Output 
3. Debug 
4. Terminal



To open Problems, press  
⇧⌘M/Ctrl+Shift+M





Integrated Terminal



Key Features



Language Support



Built-in support for 

» CSS, Sass, & Less 
» HTML 
» JavaScript, JSON, & Node.js 
» Markdown 
» PHP 
» TypeScript



Extensions add support for other languages 

» C/C++ 
» C# 
» Go 
» Java 
» Python 
» Ruby 
» Rust 
» & many, many more



Command Palette



Get used to pressing ⌘⇧P/Ctrl-Shift-P a lot, as that 
key combination opens the Command Palette 

Command Palette allows you to access all of VSCode’s 
functionality, including… 

» built-in app commands 
» built-in editor commands 
» commands for extensions 
» file navigation 
» keyboard shortcuts



⌘P/Ctrl-P lets you navigate to any file in the project by 
typing its name



⌘P/Ctrl-P



^R/Ctrl+R opens a list of recently opened folders & files 
in the Command Palette



After pressing ^R/Ctrl+R



IntelliSense



IntelliSense combines several features 

We care about code completion & quick info



Code completion 

As you type, IntelliSense lists suggestions in a small pop 
up 

Suggestions depend on the language you’re working in  

If you continue typing, the list filters to include only 
items containing your typed characters 

Press Tab or Enter to insert the selected list item



 Now type a > to complete the tag 



Let’s hit Enter to properly format…



If only there was a way 

to automate that… 🤔



If you don’t see the code completion pop up, press ⌃␣/
Ctrl-Space



Quick info 

Very short documentation explaining the purpose of… 

» an HTML element 
» a CSS property or value 
» a JavaScript method & parameter info 
» a Sass variable 
» & much more!

























If you don’t see the quick info pop up, press ⌃␣/Ctrl-
Space



Rename Tags



You type <em>Unknown Kadath</em> & realize you 
should’ve used <i> instead 

Normally you’d have to manually change both <em> &  
</em> to <i> & </i> 😠



With Rename Type, bult-in to VS Code… 

» change <em> to <i>, & it automatically changes </em> 
to </i>, OR 

» change </em> to </i>, & it automatically changes  
<em> to <i>



✏ SIDE NOTE

I have enabled Rename Tags to run automatically in 
the Settings file I am providing you soon 

Without that automation, you’d have to run it 
manually by selecting the element & doing one of 
these: 

» Invoke the Command Palette (⌘⇧P/Ctrl-Shift-P) & 
search for On Type Rename Symbol 

» Press ⇧⌘F2/Shift+Ctrl+F2  



Emmet



Emmet (formerly Zen Coding) is a set of plug-ins for 
text editors that make it very fast to code & edit HTML, 
CSS, XML, & other structured code formats 

Started in 2008 & still going strong 

Some editors (like VSCode) come with Emmet built-in 

🎉 🥳 🙌



You type p*3 & Emmet outputs: 

<p>
  |
</p>
<p>

</p>
<p>

</p>



This icon 
means it’s 
from Emmet



You type ul>li*3 & Emmet outputs: 

<ul>
  <li>|</li>
  <li></li>
  <li></li>
</ul>





You type p+ul>li*3 & Emmet outputs: 

<p>
  |
</p>
<ul>
  <li></li>
  <li></li>
  <li></li>
</ul>





You type div.container>div.row>article>
h2{Article Title}^aside>h2{Aside Title}

+p*2>lorem & Emmet outputs… well, just take a look







div.container
>div.row
>article
>h2{Article Title}
^aside
>h2{Aside Title}
+p*2>lorem

<div class="container">
  <div class="row">
    <article>
      <h2>Article Title</h2>
    </article>
    <aside>
      <h2>Aside Title</h2>
      <p>
        Lorem ipsum…
      </p>
      <p>
        Consequatur, tempore? …
      </p>
    </aside>
  </div>
</div>



VSCode enables Emmet expansions by default in 
HTML, Haml, Jade, Slim, JSX, XML, XSL, CSS, SCSS, 
SASS, LESS & Stylus files — & any language that 
inherits from any of those, like Handlebars & PHP



Emmet does a lot more than expanding abbreviations 

Matches opening & closing tags • Select all content 
inside tags • Wrap selected content inside tags • Control 
insertion point placement after expansion • Easily jump 
to the next edit point • Toggle comments • Remove tags 
• Merge lines — without selections! • Automatically 
insert image height & width • Evaluate math 
expressions • Increment & decrement numbers • Copy 
CSS values to vendor-prefixed properties



To perform almost all of those actions, you use the 
Command Palette or come up with keyboard shortcuts 
(more on those later)





Snippets



Remember how VSCode formats the <p> tags by default 
when I type them?



 Now type a > to complete the tag 





I don’t want <p>|</p> 

I want 
<p>
  |
</p> 

Snippets in VSCode allow me to do that



Simply type the start of a snippet, like p (you decide 
what the prefix will be) 

Code completion shows what will happen if you press 
Enter 

Quick info tells you what will happen if you press Enter



Let’s look at this in 
detail…



This icon 
means it’s 
from Emmet

This icon 
means it’s a 
snippet

Code preview



Perfect!



Insertion point’s 1st  
position

Press Tab to jump to 
2nd position







Note the 5 tab stops



You create different snippets for different languages 

: Code > Preferences > User Snippets 

⊞: File > Preferences > User Snippets 

Select the language in the Command Palette 

A JSON-formatted file named [language].json opens*

* More on JSON very soon!





${0} denotes the 
final insertion point 
position





I’ve already prepared html.json for you to use 

👏 👏 👏

379 lines as of September 11, 2019



: Code > Preferences > User Snippets 

⊞: File > Preferences > User Snippets 

Type html & select it in the Command Palette 

A JSON-formatted file named html.json opens



Go to http://chnsa.ws/16e 

Click the Raw button 

On the following page, press ⌘A/Ctrl-A to select all of 
the code 

Press ⌘C/Ctrl-C to copy the snippet code (everything 
from — & including! — the first { to the last })

http://chnsa.ws/16e
http://chnsa.ws/16e


Go back to VSCode & click in html.json 

Select all of the content in html.json by pressing ⌘A/
Ctrl-A 

Paste the snippets you copied with ⌘V/Ctrl-V, 
overwriting what was there 

Save what you just pasted in by pressing ⌘S/Ctrl-S 

Close html.json by clicking the × on its tab or by pressing 
⌘W/Ctrl-W



I’ve also already prepared css.json for you to use 

👏 👏 👏

32 lines as of September 11, 2019



: Code > Preferences > User Snippets 

⊞: File > Preferences > User Snippets 

Type css & select it in the Command Palette 

A JSON-formatted file named css.json opens



Go to http://chnsa.ws/1bo 

Click the Raw button 

On the following page, press ⌘A/Ctrl-A to select all of 
the code 

Press ⌘C/Ctrl-C to copy the snippet code (everything 
from — & including! — the first { to the last })

http://chnsa.ws/1bo
http://chnsa.ws/1bo


Go back to VSCode & click in css.json 

Select all of the content in css.json by pressing ⌘A/Ctrl-
A 

Paste the snippets you copied with ⌘V/Ctrl-V, 
overwriting what was there 

Save what you just pasted in by pressing ⌘S/Ctrl-S 

Close css.json by clicking the × on its tab or by pressing 
⌘W/Ctrl-W



✏ SIDE NOTE

Only needed if you’re in my CSS course 

I’ve also already prepared scss.json for you to use 

👏 👏 👏

32 lines as of September 11, 2019



✏ SIDE NOTE

: Code > Preferences > User Snippets 

⊞: File > Preferences > User Snippets 

Type scss & select it in the Command Palette 

A JSON-formatted file named scss.json opens



✏ SIDE NOTE

Go to http://chnsa.ws/1bx 

Click the Raw button 

On the following page, press ⌘A/Ctrl-A to select all of 
the code 

Press ⌘C/Ctrl-C to copy the snippet code (everything 
from — & including! — the first { to the last })

http://chnsa.ws/1bx
http://chnsa.ws/1bx


✏ SIDE NOTE

Go back to VSCode & click in scss.json 

Select all of the content in scss.json by pressing ⌘A/
Ctrl-A 

Paste the snippets you copied with ⌘V/Ctrl-V, 
overwriting what was there 

Save what you just pasted in by pressing ⌘S/Ctrl-S 

Close scss.json by clicking the × on its tab or by pressing 
⌘W/Ctrl-W



Git



Git is the world’s most popular distributed version 
control system for tracking changes in source code files 
& coordinating work on those files among multiple 
people



VSCode has built-in support for Git











If you are not in an Advanced class with me, we won’t 
be using Git



Configuration



Settings



Now we need to edit VSCode’s settings 

: Code > Preferences > Settings (or just press ⌘,) 

⊞: File > Preferences > Settings



Let’s close 
the Sidebar…



Open Settings (JSON)





VSCode stores settings in settings.json 

JSON: JavaScript Object Notation 

Open standard file format 

Stores data in attribute-value pairs & arrays



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

"Key": Value
"(Boolean or #)

"Key": [Array]

"Key": "Value"
"(String)



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Comments not allowed 
in JSON, but are in 
settings.json 
(thanks, Microsoft!)



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Commas after every key: value pair…

…except the last one



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Commas after every key: value pair 
in an array…

…except the last one



Let’s replace the default settings with some I’ve created 

Go to http://chnsa.ws/1c7  

Click the Raw button 

On the following page, press ⌘A/Ctrl-A to select all of 
the code 

Press ⌘C/Ctrl-C to copy the snippet code (everything 
from — & including! — the first { to the last })

http://chnsa.ws/1c7
http://chnsa.ws/1c7


Go back to VSCode & click in User Settings on the right 

Select all of the content in your settings by pressing ⌘A/Ctrl-
A 

Paste the settings you copied with ⌘V/Ctrl-V, overwriting 
what was there 

Save what you just pasted in by pressing ⌘S/Ctrl-S (if the 
font gets bigger, it worked) 

Close User Settings by clicking the × on its tab or by pressing 
⌘W/Ctrl-W



Keyboard Shortcuts



Many (most?) commands have a key command 
equivalent 

For example, invoke the Command Palette & search for 
Join Lines



Mac users see a 
key command: ⌃J

Windows & Linux users 
don’t get a key command



However, VSCode includes the ability to set or change 
key commands for everything



: Code > Preferences > Keyboard Shortcuts 

⊞: File > Preferences > Keyboard Shortcuts



D
EM

O
!



I suggest changing the following: 

editor.emmet.action.wrapWithAbbreviation 
⌘E ⌘W/Ctrl+E Ctrl+W 

editor.emmet.action.wrapIndividualLinesWithAbb
reviation 
⌘E ⇧⌘W/Ctrl+E Shift+Ctrl+W



Emmet: Balance (outward)

⌘E ⌘↑/Ctrl+E Ctrl+↑ 

Emmet: Balance (inward)

⌘E ⌘↓/Ctrl+E Ctrl+↓



More on the previous 2 changes in Emmet: Automate 
Your HTML & CSS 



Extensions



VSCode does a lot out-of-the-box, but you can add on 
almost any feature you can think of via extensions



Go to the Extensions View of VSCode by clicking on 
the 5th icon down (     ) on the Activity Bar on the left 
side of VSCode 

You could also: 

» View > Extensions 
» Press ⇧⌘X/Ctrl+Shift+X



You can install extensions one at a time, or you can 
install an extension pack that installs several at once





marketplace.visualstudio.com



Basics



File Templates Manager 
Ivan Zakharchanka



Makes it easy to create new HTML (& other) files



Go to the Extensions View & install File Templates 
Manager by Ivan Zakharchanka



HTML5 template: http://chnsa.ws/1b1 

Bootstrap 3 CDN template: http://chnsa.ws/1b2 

Bootstrap 4 CDN template: http://chnsa.ws/1b3 

Bootstrap 4 NPM template: http://chnsa.ws/1bz

http://chnsa.ws/1b1
http://chnsa.ws/1b2
http://chnsa.ws/1b3
http://chnsa.ws/1bz
http://chnsa.ws/1b1
http://chnsa.ws/1b2
http://chnsa.ws/1b3
http://chnsa.ws/1bz


✏ SIDE NOTE

FYI where templates are stored (in case you want to 
back them up) 

: ~/Library/Application Support/Code/User/
CodeTemplates/ 

⊞: %HOME%\AppData\Roaming\Code\User\
CodeTemplates\



Now that File Templates Manager is installed, here’s 
how to use it



Invoke the Command Palette (⌘⇧P or Ctrl-Shift-P)



Type until you see New File From Template… appear 
& press ↩/Enter



The Command Palette now 
shows a list of templates



Type until you see the template you want 
& press ↩/Enter



Type the name of the file you want to create 
(do not type the extension!) & press ↩/Enter…



And here’s your new file, 
ready to edit!



Projects+ 
Fabio Spampinato



Manage saved projects



Go to the Extensions View & install Projects+ by Fabio 
Spampinato



You will now see a 6th icon on the Activity Bar:  

Click it to view your saved projects 

Click on a project to switch to that project





Group projects!

Current project



To add a new project, invoke the Command Palette & 
enter project save 

Give the project a meaningful name & press Enter 

Enter an optional description & press Enter 

Enter an optional group (e.g., if you want to group your 
projects by client or course) & press Enter 

Your project now appears in Projects



Live Server 
Ritwick Day



View your code live in a browser, as you work on it



Go to the Extensions View & install Live Server by 
Ritwick Dey



Look in VSCode’s status bar & you’ll see Go Live 

Click on it to start the local server 

Click again to stop the local server



✏ SIDE NOTE

Sometimes, for some reason, Go Live doesn’t appear 
in the Status Bar 

If that happens… 

» Invoke the Command Palette with ⌘⇧P/Ctrl-Shift-P 
» Enter open with live server to start the local 

server 
» Enter stop live server to stop the local server



💡PRO TIP

By default, Live Server creates the web server at port 
5500 

Sometimes Live Server gets confused & won’t start 
because port 5500 is in use 

The fix? Enter the following in settings.json (I’ve 
already done this for you): 

"liveServer.settings.port": 0,



💡PRO TIP

Leave the Live Server running in your web browser! 

Do not close your web browser after looking at the 
webpage you’re working on!



Project Templates 
cantonios



Project Templates allows you to create entire projects 
from folders containing pre-made files & folders



File Utils 
Steffen Leistner



File Utils makes it easy to duplicate, move, rename, & 
delete files & folders



Right-click on a file or folder & select: 

» Duplicate 
» Move 
» Rename 
» Delete





Live Share Extension Pack 
Microsoft



Live Share Extension Pack installs 4 extensions: 

» Live Share: real-time collaboration on code 

» Live Share Audio: audio calls 

» Peacock: changes color of your workspace to 
distinguish collaboration workspace from others 

» Team Chat: messaging while collaborating (you can 
use Discord or Slack if you’d like)





Colors



Color Picker 
anseki



Color Picker lets you generate colors using a GUI 

Click in a color & press ⌥C then P/Alt-C then P





indent-rainbow 
oderwat



indent-rainbow colorizes your indentation levels





Automation



Auto Close Tag 
Jun Han



Auto Close Tag automatically closes tags for PHP, 
JavaScript, & other languages



VSCode has built-in support for auto-closing tags in 
HTML 

Type <p> & VSCode automatically creates </p> 

Auto Close Tag adds support for PHP, JavaScript, & 
other languages



Path Autocomplete 
Mihai Vilcu



Type paths far easier by letting VSCode do the work for 
you



Go to the Extensions View & install Path Autocomplete 
by Mihai Vilcu



Autocomplete paths to files as you type 

You can start with… 

» / ← I recommend you (almost) always start with this 
» .. 
» ./ 
» folder name 
» file name





Duplicates?!? 

¯\_(ツ)_/¯







Placeholder Images 
Jake Wilson



Easily insert placeholder images (temporary images 
while a design is still being finalized)



Supports the following services: 

» DummyImage.com 
» Fake Images Please 
» LoremFlickr 
» LoremPixel 
» Pipsum 
» placehold.it ← Garbage 

» Placekitten 
» Placeskull 
» Unsplash

http://DummyImage.com
http://placehold.it
http://DummyImage.com
http://placehold.it


Invoke the Command Palette, enter in Placeholder, & 
select Placeholder Images: Insert new image 

Select the service you wish to use 

Enter the appropriate information























Spell Right 
Bartosz Antosik



Spell Right checks your spelling 

If you don’t see it working, click on the eye in the 
bottom right status bar & select a language or languages 



F8 jumps to next spelling error (& other errors as well) 

⇧F8/Shift+F8 jumps to previous spelling error (& other 
errors as well)



To show a context menu with suggestions or to add a 
word to your dictionary: 

» ⌘. (macOS) 
» Ctrl+. (Windows or Linux) 
» Click the lightbulb 

You can also use the Command Palette



Themes



Personalize the way VSCode looks with a color theme, 
which changes the colors of everything in VSCode





» Abyss 
» Dark+ (default dark) 
» Kimbie Dark 
» High Contrast 
» Light+ (default light) 
» Monokai Dimmed 

» Monokai 
» Quiet Light 
» Red 
» Solarized Dark 
» Solarized Light 
» Tomorrow Night Blue

VSCode comes with several color themes pre-installed



I included Monokai Dark Soda in GrannePack HTML





You can pick your own 

Go to Extensions View & search for color theme 

Click on a theme that interests you 

You should see a screenshot on the right to help you 
decide if you want to check out the theme 

No screenshot? Forget it!





I suggest starting with these, as they are widely 
supported by almost all code editors: 

» Solarized (light or dark) 
» Soda (weirdly, there aren’t any light Soda themes, but 
Espresso Soda by Daur Gamisonia works) 

» Monokai (I use Seti Monokai by SmukkeKim myself, but 
I also really like Monokai Dark Soda by Adam Caviness, 
as it combines the best of Monokai & Dark Soda) 

» Material 
» GitHub 
» Dracula



When you find a theme you like, click the green  Install  
button 

After it installs, click the blue Reload   button 

: Code > Preferences > Color Theme 
⊞: File > Preferences > Color Theme 

The Command Palette will open showing all your themes 

Select the one you installed & press ↩/Enter to enable it

 Install

 Reload 



A file icon theme puts little icons to the left of your files 
when you are in Explorer View





VSCode comes with 1 icon theme pre-installed: Seti 

I included Material Icon Theme in GrannePack HTML







You can pick your own 

Go to Extensions View & search for icon theme 

Click on a theme that interests you 

You should see a screenshot on the right to help you 
decide if you want to check out the theme 

No screenshot? Forget it!



I suggest starting with these: 

» Material Icon Theme by Philipp Kief ← what I use 
» vscode-icons by Roberto Huertas 
» VSCode Great Icons by Emmanuel Béziat



When you find a theme you like, click the green  Install  
button 

After it installs, click the blue Reload   button 

: Code > Preferences > File Icon Theme 
⊞: File > Preferences > File Icon Theme 

The Command Palette will open showing all your themes 

Select the one you installed & press ↩/Enter to enable it

 Install

 Reload 









CSS-Specific





IntelliSense for CSS class names 
Zignd



Autocomplete CSS classes in your HTML as you type



Go to the Extensions View & install IntelliSense for CSS 
class names by Zignd



As you type class=", a list of class names will appear 
from your local CSS files & any remote ones you’ve 
linked to 

As you continue to type — e.g., class="le — the list will 
narrow down 

Select the correct match & press Enter to autocomplete 
the class name









Narrow it down further…



Now press Enter…





Peeking



Want to quickly edit your CSS without leaving your 
HTML file? 

Peek! 

Put your insertion point inside the selector & do this: 

» Invoke the Command Palette (⌘⇧P/Ctrl-Shift-P) & 
search for Peek Definition 

» Press ⌥F12/Alt-F12



Press ⌥F12/Alt-F12



Edit & press Save to update!



Comand Palette



⌘⇧O/Ctrl-Shift-O lets you use the Command Palette to 
jump to a specific symbol in a file



⌘⇧O/Ctrl-Shift-O



⌘⇧O/Ctrl-Shift-O



⌘⇧O/Ctrl-Shift-O



⌘⇧O/Ctrl-Shift-O



⌘⇧O/Ctrl-Shift-O



Thank you! 

scott@granneman.com 
www.granneman.com 
@scottgranneman 

jans@websanity.com 
websanity.com
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Bonus



Command Palette



⌘⇧P/Ctrl-Shift-P specifically opens the Command 
Palette so you can run editor commands that affect your 
code



All editor commands

⌘⇧P/Ctrl-Shift-P



Most recent editor commands

⌘⇧P/Ctrl-Shift-P



⌘⇧P/Ctrl-Shift-P

Filter commands



? shows you a list of available commands for VSCode 
itself, not the editor





Changelog 

2020-06-09 1.10: Minor fixes & updates



Changelog 

2020-04-11 1.9: Moved Configuration much higher; 
changed Emmet keyboard shortcuts to fit with new 
scheme; added Why VSCode? section; removed Auto 
Rename Tag because the functionality is now built in to 
VS Code 1.44 as Synced Regions; added keyboard 
shortcut to open Problems panel; removed CSS Peek 
because peeking is now built in, so explained; added CSS-
Specific section & added content; added Bonus section; 
added open recently-opened folders to Command Palette



Changelog 

2019-09-14 1.8: Removed expand-region by Le Trieu 
because Emmet does it; removed Sort Lines by Daniel 
Imms because now built in; added extension screenshots 

2019-09-11 1.7: Added css.json & scss.json snippets; 
added installation instructions for Linux; updated all GUI 
screenshots; added GrannePack slides & did a little 
rearranging; added section on Emmet; split Configuration 
into sections; little improvements everywhere



Changelog 

2018-11-29 1.6: Added section on macOS Disclosure 
Buttons in Initial Info; added screenshots for Windows 
zipping & unzipping; added slide re: zipping for macOS; 

2018-10-29 1.5: Minor formatting fixes; added slide re: 
Live Server port 5500; added hyperlinks to slide links; 
added DEMO! slide; cleaned up small stuff; added 
suggested keyboard shortcuts



Changelog 

2018-09-15 1.4: Switched out File Templates to File 
Templates Manager because the latter works on 
Windows; added details on unzipping 

2018-09-03 1.3: Took Your Username out of Initial Info 
& put it in with File Templates extension; Added / & \ to 
Initial Info; added instructions for using File Templates; 
added Side Note & Pro Tip to Live Server; labeled 
screenshots for HTMLHint & CSSTRee validator



Changelog 

2018-08-29 1.2: Added Initial Info section with macOS Meta Keys, 
Unzipping, Show Extensions, Main Project Folder, & Your 
Username; better instructions for copying html.json & 
settings.json; added icon for Extensions button in First 
Extensions; added note that Git is for advanced classes; much 
better instructions for installing color & file icon themes; better 
instructions for File Templates 

2018-08-20 1.1: Updated Portable VSCode; added text re: commas 
in JSON 

2018-06-22 1.0: First release 



TODO 

» Add screenshots showing how to change key 
commands
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